
Avenue in Palo Alto, CA, Willow Bend in 
Plano, TX (a suburb of Dallas), Interna-
tional Plaza in Tampa, FL and Westfarms 
in West Hartford, CT.

Only one location in Georgia has 
been rumored - for the intersection of 
Broughton and Barnard Streets near the 
riverfront in Savannah, and Apple has 
not officially announced this location. 
No mention has been of an Atlanta loca-
tion, as of yet, and calls to the Simon 
Property Group, the management com-
pany for such prestigious Atlanta loca-
tions as Gwinnett Place mall, the Mall 
of Georgia, Northlake Mall, Town Center 
at Cobb, and the most likely locations 
- Phipps Plaza and Lenox Square mall, 
have resulted in “no comment” and the 
suggestion that we check with Apple 
themselves.

Meanwhile, at the Worldwide Devel-
oper’s Conference keynote last week, 
Steve Jobs announced that Apple is 
hoping for their retail locations to turn 
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uniform white color case, and the clam-
shell design has been replaced in favor 
of the TiBook’s retro-square shape. Also 
gone are nearly two pounds of weight, 
leaving only 4.9 pounds behind. This 
weight savings also are inherited from 
lessons learned in the TiBook, and mag-
nesium is the element used to give this 
new portable its weightless feel. This 
waif-like weight of the iBook places it 
third in all-time lightest PowerBooks 
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NEW IBOOK TO SWOON OVER
By Chris Waldrip, Newsletter Director
(chris_waldrip@atlmug.org)

It’s almost a cliché. Apple has released a redesign product and it 
seems to already be an unmitigated success. Critics and consum-
ers alike are repeating their gaga reaction to the iMac, the original 

iBook, and the Titanium PowerMac.
The infamous industry pundit John C. 

Dvorak, who makes headlines when he 
says something nice about Apple, will 
not be able to call the new iBook a 
girlie laptop. The new 
iBook owes its new 
design to the sleek 
and slim design of 
the Titanium 
PowerBook (TiBook), 
while retaining the 
elements that make 
it an iBook. The over-
all size of the iBook 
is best described as 
a sub-notebook, its 
dimensions measure 

11.2 inches wide, 9.1 inches deep, and 
an extremely respectable 1.35 inches 
thick.

Jason O’Grady’s website has dubbed 
the new laptop 
“The Son of 
TiBook,” 
although it’s 
official Apple 
moniker seems 
to be Dual USB 
iBook.

Gone from 
the new iBook 
are the multi-
colored panels 
in favor of a 
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Apple’s new iBook looks sleek, and lets you edit 
your own digital video for less.
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APPLE OPENS RETAIL STORES
By Chris Waldrip, Newsletter Director
(chris_waldrip@atlmug.org )

After much anticipation Apple finally opened their first stand-
alone retail specific store in suburban Washington, D.C. The 
space, located in the Tyson’s Corner mall in McLane, Virginia 

was guessed to be the freshman location due to invitations to the media 
from Apple, unsurprisingly leaked by the media.

A second location, in Glendale, CA, a 
suburb of Los Angeles, opened within 
a week of the McLane location. Apple 
announced, at the opening ceremony 
in McLane that 23 
more stores are 
to open by the 
end of the year, 
at a pace of one 
every ten days.

If Apple’s job 
postings are any 
indication, then 
at least ten stores 
are on the verge 
of opening. Apple 

is hiring full-time and part-time, employ-
ees, managers, and Geniuses for stores 
at Crossgates Mall in Albany, NY, 
the Mall of America in Bloomington, 

MN, Walden Gal-
leria in Buffalo, 
NY, Easton Town 
Center in Colum-
bus, OH, Saddle 
Creek in Ger-
mantown, TN (a 
suburb of 
Memphis), Fash-
ion Island in 
Newport Beach, 
CA, on University A look at Apple’s new retail chain.

Im
age courtesy of Apple Com

puter
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MESSAGE FROM THE CHAIR
By Michael Henigan, AMUG Chair 
(michael_henigan@atlmug.org )

WOW! That is the only word I can 
think of to describe the new iBook that 
was recently released by Apple Com-
puter.  So how many of our members 
will just HAVE to get one of the new 
iBooks? I know that I am certainly think-
ing about it.

Every time that Apple Computer 
comes out with something new, it cre-
ates this “Apple Lust” that you just want 
to feed. Sounds just like a geek doesn’t 
it <LAUGH>! I guess that is why I am 
a member of the best kind of user group 
there is, a Macintosh User Group!

Did you know that Shawn King in 
his latest Mac Daily Report (See the 
site, www.macshowlive.com/
dailyreport.html) did a comparison 
between Macintosh Users and Cultist.  
There is a study that defines what a cult 
is and sure enough, we score on 3 of 
the 4 points that mark you as a cult 
member.  Maybe that is so, but we all 
stand up for and around the best com-
puter system that exists.

A great resource for MUG members 
that I most highly recommend is 
The Mugcenter (www.mugcenter.com).  
Chuck Joiner, Chairman of the Apple 
User Group Advisory board is the 
founder and inspiration behind the 
site.  It is a great place to get informa-
tion on what is happening with Macin-
tosh Chats, MUG news, and the latest 
and hottest news from Apple for User 
Groups.

Apple is continually updating their 
product line and they keep coming out 
with design innovations and surprises 
that certainly keep the business com-
munity and consumers amazed. And the 
guessing continues with Macworld New 
York 2001 just around the corner!

AMUG will be well represented at this 
year’s Macworld. Several members of 
the board will be attending and bringing 
you the latest and hottest news from the 
show floor. We’ll be posting reports to 
the Online Community. So if you don’t 
already have an account on the Online 
Community, the next question is… 

Why Not?

The AMUG Online Community is a 
wonderful place to feel the togetherness 
and camaraderie of being a member of 
AMUG. If you have a nagging problem 
that you can’t get fixed, or need some 
hardware assistance, then all you have 
to do is simply post a message in one 
of the many folders in the community 
and watch the answers come from other 
members of the community.

Do you want access to the companies 
that give MUG members discounts? Well 
the codes for the discounts are ONLY 
listed in The Online Community! Do 
you have computer software or hard-
ware to sell, or have those extra Braves 
tickets that need a new home? All you 
need to do is simply let our community 
know and they will be happy to make 
you an offer you may not want to refuse.

NOW,  is the time to contact Sheryl 
McDonald

(sheryl_mcdonald@atlmug.org)
or Kathleen Innes

(kathleen_innes@atlmug.org), and 
get active in our community.

How many of our members are aware 
that you can get BONUS months added 
to your membership? How you ask? 
It’s simple… recruit a new member! 
Anyone who recruits a new member 
normally gets a month added to his 
or her membership. Until July 1, we 
are offering a BONUS month for each 
member you recruit, that’s a total of 2 
BONUS months onto your membership.

We also recognize if you recruit family 
or corporate memberships by giving you 
even more BONUS membership time. 
If you sign up a corporate or family 
membership then you get 3 MONTHS 
BONUS MEMBERSHIP TIME! Do you 
feel that you have someone who might 
like to be a member, but you feel a 
little awkward asking him or her to join? 
Steer them to a member of our BoD and 
let them help you out.

Hope to see everyone at the next 
meeting!

    Mike
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AMUG’s April On-Line Poll: 
Will you be upgrading to 
Mac OS X?

• Yes ........................................ 58%
• No......................................... 25%
• I haven’t decided yet!........... 17%

AMUG’s May On-line Poll: 
How fast is your internet 
connection?

• Less than 56k (slow modem)
• 56k or ISDN (fast modem)
• Cable Modem / DSL
• Office Connection (T1 or faster)
• Other / Not Sure
• No internet connection

(http://www.atlmug.org/maclanta)

IN THE NEWS
Apple Announces Mac OS X - 
Now Installed

Steve Jobs announced, during the key-
note of the Worldwide Developers Con-
ference, that Apple had already begun 
to pre-install Mac OS X on all shipping 
systems. This comes at least two months 
ahead of their previously announced 
intention to begin late in the summer.

The default operating system is set to 
Mac OS 9.1, but users can easily change 
this when, and if, they feel ready.
Long Live the LCD

Apple has announced that their prod-
uct line will now include only LCD 
based displays. A 17” LCD display with 
1280 x 1024 resolution was announced. 
The pricing for Apple’s LCD lineup was 
also modified. The 15” display is now 
$599, the new 17” is $999, and the 24” 
Apple Cinema Display has dropped to 
$2499.
Mac OS X Server 2.0 Released

Those in attendance at the Worldwide 
Developers Conference were the first to 
learn of the release of Mac OS X Server 
2.0. This latest release, based on Mac 
OS X, includes several powerful server 
applications such as the Apache web 
server, Samba for Windows file sharing, 
WebObjects 5 application server and 
QuickTime Streaming Server 3.
WebObjects 5 Now Available

Included in the host of announce-
ments made at the Worldwide Devel-
opers Conference was the release of 
WebObjects 5. This latest release has 
been built using Java, which will help 
facilitate its use on multiple platforms.

Macromedia Freehand 10.0 
Released

Macromedia promised Freehand 10 
would be coming to Mac OS X users 
quickly. The latest release of Macro-
media offers several new features: A 
new user interface similar to other 
Macromedia products, Flash preview, 
customizable master pages, a few new 
illustration tools, in addition to compat-
ibility with Mac OS X. Look for more 
information regarding Freehand 10 in 
June when we’ll be hosting a presenta-
tion from Macromedia.
Mac OS X Updates Coming Fast 
And Furious

Since its release on March 24th there 
have been a total of three updates to 
Mac OS X. The updates have been minor 
in nature. The latest has offered the abil-
ity to burn CD’s through iTunes only. 
The second update fixed a security hole 
in the FTP implemented in BSD kernel, 
which Apple chose to use as the base of 
Mac OS X.

While Apple remained mum when the 
obscure security hole was announced by 
several watchdog groups. The update to 
fix the problem came within a week. 
Some experts argue that the updates are 
coming too fast, and are offering fixes 
that are too minor, but others note that 
Linux and Microsoft updates are too far 
and in between. Apple’s updates seem 
to indicate that Apple is intent on fixing 
as many minor problems as it can, as 
fast as it can. Whether or not these 
updates will come as frequent in the 
future is unknown.

The updates are available through 
Software Update in the system prefer-
ences. The next update, 10.0.5, skipping 
10.0.4, is rumored to be released any 
day now, if it hasn’t by the time this is 
printed.
Apple Refurbishes Its Refur-
bished Warranty

For a couple of years now if you 
bought a refurbished piece of hardware 
from Apple you would only receive a 
90 day warranty. The same warranty you 
would receive from Apple on service 
work out of warranty. But in an amazing 
change of face Apple has revised its 
policy. Buyers of refurbished equipment 
from the Apple Store, or Apple Autho-
rized resellers, can now receive a one 
year, limited, warranty - the same war-
ranty available if the equipment was 

new. And refurbished equipment pur-
chased on or after May 1st is eligible for 
extended Apple Care, a feature not avail-
able previously to refurbished equip-
ment.
SoundJam Discontinued

When Apple released iTunes many 
noticed similarities with SoundJam. But 
instead of copying SoundJam, Apple 
simply hired the creator’s of SoundJam. 
That was the first shoe, and now 
the second shoe has fallen. Casady & 
Greene, the publisher of SoundJam, 
announced last week that the creators 
of SoundJam have decided to devote 
their time fully to iTunes. Bug fixes for 
SoundJam may still be forthcoming, but 
active development has ceased.
Quicktime 5.01 Released

Long in public beta QuickTime 5 
has finally been released as a finished 
product. QuickTime 5.01 enhances per-
formance, and introduces some minor 
changes in the interface. The circular 
volume control has been replaced with 
a slider, control buttons now have 
the Aqua look. QuickTime 5.01 also 
now supports a new DV codec for 
converting video to and from digital 
video, improved AppleScript support, 
complete MPEG-1 and Flash 4 compat-
ibility, all in addition to support for 
Apple’s new Cubic VR, which allows 
full 360° by 360° (up and down, and 
all around) QuickTime VR scenes, an 
improvement over simple 360° scenes.

QuickTime 5.01 is free for simple use, 
but $30 is required to access the Pro fea-
tures (full screen mode among others). 
Owners who registered previous ver-
sions of QuickTime prior to October 
12th, 2000 will not be able to use their 
old registration code.
NT Servers Cost Even More

J.S. Wurzler Underwriting Managers 
are charging from 5 to 15% more for 
hacker insurance for users of Windows 
NT servers on the internet, as compared 
to users of Unix or Linux based servers. 
Mac OS X is based on the BSD flavor of 
Unix.

The price difference is based on 
a study they conducted showing that 
Windows NT is more vulnerable, and 
requires more frequent security 
updates.

Even Windows 2000 Server has shown 
weakness in recent months. Microsoft 
has promised that Windows XP Server 
will feature even stronger security.

http://www.atlmug.org/maclanta#poll
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a slight profit next year, but is keeping 
expectations low for this year – despite 
the amazing numbers reported for the 
first weekend of their first store. The 
McLean location had almost $600,000 in 
sales with more than 7700 visitors in its 
first weekend.

The stores themselves have appar-
ently been under design for some time. 
An entire mock up store apparently 
was built in a warehouse where exec-
utives, and employ-
ees could critique 
the layout and 
design. The final 
design and layout 
is very simple. The 
color theme is black 
and white (hinting 
at Steve Job’s per-
sonal touch) and 
feature straight 
lines and slight 
curves. Signage is at 
a minimum through 
out the store, but 
very effective. The 
window fronts fea-
ture plenty to catch 
the eye of passers 
by.

Inside the store 
you’ll find plenty of 
Mac’s (36 at the 
McLane location), all of them networked 
with access to the internet via AirPort. 
Within the first quarter of the store 
you’ll find Apple’s entire hardware line. 
The rest of the store is divided into sec-
tions titled Genius, Home, Music, Pro, 
Movie/Photos, and Etcetera. Each sec-
tion offers plenty of software, Apple 
hardware, and accessories. In stock are 
over 300 software titles and 6 different 
brands of digital camcorders, digital 
cameras, MP3 players, and handheld 
PDA’s. All are accessible for customers to 
handle, and even hook up and try them 
out.

As an example of what these sections 
contain, the Home section features sev-
eral iMac’s setup at a child-sized desk. 
These iMac’s feature several educational 
titles and offer children, and their par-
ents, the chance to look and use the 
various software titles stocked in the 
area. In the Movies and Photo’s section 
digital camcorders and cameras can be 
connected to Mac’s and the visitor can 

experiment with iMovie 2.
In addition to the software, hardware, 

and accessories carried by the store, 
there are two other area’s customers 
will want to investigate: A theater at the 
back of the store and the Genius Bar 
to one side of the store. The theater 
features a large 10’ projection screen 
and bench seating and offers a regular 
schedule of pre-recorded presentations 
highlighting Apple’s software and hard-
ware offerings and its latest technology. 

It’s unknown at this time if the theater 
will offer live broadcasts of significant 
Apple events, such as MacWorld Key-
notes.

At the Genius Bar specially trained 
employee is prepared to answer your 
Mac related questions. If the genius 
can’t answer your query, a red phone 
behind the bar offers a direct link with 
Apple’s engineers in Cupertino. The 
Genius Bar also offers warranty, and 
out of warranty, service work for Apple 
products from the original iMac through 
to the most recent releases. Laptops and 
Cubes are sent to Apple’s central service 
facility, but most work is done in-house.

Interestingly this service has been 
downplayed. This is thought to be in 
kind to the feelings of CompUSA, Micro 
Center, and other local Apple resellers 
whose largest source of income is in 
service work. By not highlighting this 
ability to do service work, Apple seems 
to be trying to ease the tension between 
itself and its retail partners.

An interesting question posed by 

those in the computer retail industry 
has been “what is Apple thinking!” Many 
have suggested that Apple’s retail offer-
ing comes too late, or at least at a bad 
time considering the recent downturn 
in the industry as a whole.

    An example of what many expect 
will happen to Apple is with Gateway. 
The number two computer manufac-
turer has recently announced that it’ll 
be closing a significant number of 
its Gateway Country Stores. And the 

margins (profit) 
in the computer 
retail industry are 
renown for being 
razor thin, typ-
ically 3-7% for 
hardware. Apple 
has traditionally 
had higher mar-
gins than other 
computer manu-
facturers.

Apple has coun-
tered that it isn’t 
expecting its retail 
stores to become 
a significant rev-
enue source. 
Instead, Apple is 
hoping that the 
Apple stores will 
help to familiarize 
the 95% of com-

puter buyers unfamiliar with the Macin-
tosh with Apple’s offerings. They 
suggest that you think of the Apple 
stores as another marketing tool, one 
that Apple hopes will break even, and 
maybe even make a slight profit by next 
year.

Another look at Apple’s new retail chain.

Im
age courtesy of Apple Com

puter

CONTINUED FROM “APPLE OPENS RETAIL STORES”, PAGE 1

Confirmed Soon-To-Open
Apple Store Locations

Crossgates Mall, Albany, NY
The Mall of America,

Bloomington, MN
Walden Galleria, Buffalo, NY
Easton Town Center

Columbus, OH
Saddle Creek, Germantown, TN
Fashion Island

Newport Beach, CA
University Avenue, Palo Alto, CA
Willow Bend, Plano, TX
International Plaza, Tampa, FL
Westfarms, West Hartford, CT.
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(the Duo and 2400 place first and 
second).

The smaller size still leaves you a 
12.1” active matrix display, but now sup-
ports resolutions up to 1024 x 768. A 
unique feature here is how the lid is 
hinged, it uses an “L” shaped hinge that 
enables the display to swing back 
- you have to see it to reall y under-
stand. An 
ATI RAGE 
mobility 
128-bit 
graphics 
accelerator 
with 8MB 
of SDRAM 
VRAM and 
AGP 2x 
support combine with the ability to use 
640 x 480 and 800 x 600 resolutions. 
In short it makes a great portable game 
machine.

Also gone from the iBook are slower 
processors. A 500MHz G3 processor and 
a 66MHz bus provide enough speed for 
most consumer-level user’s needs.

Apple has also heard a few things 
from previous owners. Potential Buyers 
have a choice of 64MB or 128MB RAM 
pre-installed. A suggestion for those 
interested in jumping right into Mac OS 
X: you’ll want to go for the 128MB. But 
many would suggest buying the mini-
mum configuration, and upgrade with 
third party RAM for less afterwards.

Other configurable options include 
the optical drive installed. Buyers can 
opt for an old fashioned CD-ROM drive, 
a DVD-ROM drive for watching DVD 
movies, a CD-RW drive letting you burn 
your own CD’s, and a CD-RW/DVD 
combo drive letting you watch DVD 
movies and burn your own CD’s.

A 10 or 20GB hard drives are the 
only storage options available. Like the 
previous iBook, and the new TiBook, 
there is no expansion bay. But upgrad-
ing the hard drive is possible, and will 
be very popular among those experi-
menting with editing digital video.

Part of the design of this new iBook is 
the placement of all the connectors on 
the left side. Included are a 56k modem, 
10/100Base-T Ethernet, one FireWire, 
two USB, a special RGB Video Out, and 
an AV connector seen first on the last 
generation of previous iBook.

The special RGB Video Out utilizes 

CONTINUED FROM “NEW IBOOK TO SWOON OVER”, PAGE 1 an adaptor cable letting you hook up a 
regular VGA monitor to the iBook. Users 
will only experience video mirroring, or 
the same video on both the iBook and 
the external monitor. The AV connector 
uses a special 1/4” headphone-style con-
nector. Using a regular headphone jack 
will give you full stereo, but the longer 
AV connector will give composite video 
for use with standard televisions.

While the 
new bat-
tery is 
easier to 
replace, it 
does carry 
a slightly 
shorter bat-
tery life of 
only about 

five hours. And the iBook still supports 
AirPort, and comes with several pro-
grams pre installed, including iTunes, 
iMovie 2, AppleWorks 6, Mac OS 9.1, 
and since the Developers Conference 
Mac OS X is also now pre-installed. Pric-
ing starts at a remarkable $1299. The 
one item that is still missing on the 
iBook though is a PC Card slot, but most 
users won’t miss this.

Apple seems to have found the prod-
uct that will revive their educational 
sales. Apple announced that they have 
made the single largest sale of laptops 
to education in a single sale to Virginia’s 
Henrico County Public Schools. The 
school system has already ordered 
23,000 iBooks for all of their Middle 
and High school students and teachers. 
Future plans include equipping every 
student and teacher in their school 
system.

I can’t wait to see what the next rede-
signed product will be. New iMac’s? 
New PowerMac G4’s?

All the ports you’ll need, all in one convenient location.

Im
age courtesy of Apple 

Com
puter

Dual USB iBook Configurations 
and Apple Store Pricing

12.1-inch TFT XGA display, 500MHz PowerPC 
G3, 256K on-chip L2 cache, 10GB Ultra 
ATA drive, 8MB video memory, 10/100BASE-T 
Ethernet, 56K internal modem, RGB video 
output, Two USB ports, FireWire port, AC 
adapter, Battery
64MB RAM and CD-ROM ........ $1299
128MB RAM and DVD-ROM .... $1499
128MB RAM and CD-RW ......... $1599
128MB RAM and

CD-RW/DVD-ROM............. $1799

IBOOK FIRST IMPRESSIONS
By David Whitehead,
Publicity Director
(david_whitehead@atlmug.org )

As the recipient of some fortu-
itous timing and emphatic plead-
ings, I am now the proud owner 
of a new Apple iBook. My first 
impression: Wow.

It’s beautiful.

As a former graphic designer, I 
always seem to notice when things 
are designed well. In the case of 
the new iBook, I was blown away. 
It is simply a gorgeous piece of 
hardware. I gingerly lifted it out 
of the Styrofoam when I first got 
it, but that gentleness was unnec-
essary. While it looks elegant, it 
feels very sturdy and rugged (in 
fact, it feels heavier than it looks, 
although the quick appropriation 
of a postal scale confirmed its 
just under five pound weight). 
And proof of that ruggedness was 
apparent when the iBook fell off 
the couch. It is a well-designed, 
solid machine. Phew.

After booting up, I easily added 
the iBook to my home network 
using Apple’s setup utility. Within 
minutes (I’ve subtracted the actual 
time I spent just staring at the 
computer), I was up and running 
and surfing the web. The iBook is 
very snappy, opening most appli-
cations very rapidly.  

Surprisingly, even Mac OS X ran 
decently on the iBook. I haven’t 
upgraded the RAM yet, so I was 
running X with the minimum 
128 MB of RAM. But once I 
opened more than two appli-
cations concurrently, a dramatic 
slowdown did occur. But with a 
RAM increase, I believe the iBook 
will run OS X just fine.

As I get to play with it more, 
I’ll provide a more in-depth insight 
into its pluses and minuses, but 
my initial impression is that this 
is a great laptop and definitely an 
eye-catcher!

mailto:david_whitehead@atlmug.org
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MACROMEDIA IN JUNE
TUESDAY, JUNE 19TH AT MACQUARIUM

PRESENTER: MACROMEDIA
David Weisman, Sales Engineer for Macromedia, will 

be giving us a Tour-de-force demonstration of their 
complete line of web design software.

Join AMUG for another great web publishing software 
demonstration of the following products:

• Dreamweaver
• Fireworks
• Flash
• Freehand
• Director Shockwave Studio

In order to give David enough time to demonstrate all 
these great software packages, we’ll be having 
a short version of our Question & Answer 
session. It will begin at 7:00 pm and run for 
15 minutes. If your question is not answered, 
then you can ask it at the conclusion of the 
meeting. Someone there will be glad to help. 
At 7:15 pm David will begin his demonstra-
tions. We’ll have a short break at 8:15 pm and 
go until 9 pm with a door prize giveaway. 
Details on door prizes will be posted on 
the AMUG website and Online Community 
shortly.
Come on out to Macquarium and check out 
the latest in web publishing solutions from 
Macromedia!

Thanks For Joining AMUG
Philippe Belland, John Brady, Robert 
Cameron, Candace Chapman, Teresa 

Eddings, Kevin Garrison, Dennis Golden, 
Michael Jacobson, Thomas Jenkins, Virginia 

Jewell, Jim Kanter, Neil Kayes, Topher Kohan, 
Michael Layne, Howard Levine, Alun Owen, 
Kathy Porter, Gerald Reid, Rick Root, Dan 

Searight, Daniel Williams

And For Renewing
Your Membership

Allegra Anderson, Ron Anderson, Joi Barlow, 
Bruce Barrett, Michael Brody, Chris Boyce, 

Michael Carew, Ted Cashin, Wikston 
Churchill, Russ Curry, Gilbert Dailey, Jerry 
Robert Ellison, Etheridge, Rebecca Ewing, 
Louis Favorite, Jr., Robert Flack, Kathleen 

Grawe, John Goodman, Elizabeth Harding, 
Michael Holmes, Natalie Howard, Barbara 

Jackson, Todd Johnson, Waynon Johnson, T. 
Kevin Kilgore, Stephen Kramer, Henry Krebs 
III, Charles Lackey, Don Larson, Donna Lee, 
Jodi Lewis, Richard Lovell, Marcus Merritt, 
Robert Metz, Philip Milazzo, John Mistretta 

DDS, Wayne Moody, Robert Morley, Herbert 
Mower, Jr, David Roberts, Philip Rogers, 
Roger Rudow, Jim Shewmaker, Patricia 

Schiffman, Walter Schmidt, Mark Schultz, 
Gregory Scott, Dr. Herbert Stone, Laurence 
Tuten, A. Bowdoin Van Riper, Mark Walker, 
Allen Walters, John Whitt, Caroline Widmer, 

Mark Yancich, Peter Yeung, Bob Werst

MAY MEETING SUMMARY
Stan Allen, Programming Director
(stan_allen@atlmug.org )

As the Program Director for AMUG, it is my responsibility to 
schedule subjects and product demos for all the monthly meet-
ings. My biggest nightmare is if a speaker doesn’t show. Well, 

that happened during our May meeting with Adobe. Our guest’s flight 
was delayed and he ended up being late. It was time for a quick Plan B!

Fortunately, in the Mac community 
there is a wealth of knowledgeable 
experts who are willing to help out… 
Aaron Hillegass with the Big Nerd Ranch 
stepped in and gave the group a short 
overview of programming for OS X in 
the Cocoa environment. For developers 
out there who are wanting to learn 
more, Aaron, an experienced software 
developer with Apple and NeXT, holds 
a week long advanced training course at 
locations both in Atlanta and in Scenic 
Asheville, North Carolina. For more 
information, check out the Big Nerd 
Ranch web site, www.bignerdranch.com. 
Aaron has agreed to come back and do 
a special evening with OS X on develop-
ing in Cocoa, watch the web site for 
future details,

In addition, we had a representative 

APRIL DOOR PRIZES
Ken Brockway ...................Quicken 2001
Warren Castaneira ....................................
 DragStrip/Flashback Combo
Ali Demarci.............. Aladdin Transporter
Ali Demarci....................Microsoft T-Shirt
Bob Flack...........................Quicken 2001
Debby Kratovil......... Aladdin Transporter
Alum Owen ................Aladdin Drag Strip
Charles Smith ................Microsoft T-Shirt
Wheat Williams..................Quicken 2001

MAY DOOR PRIZES
Will Jones .......................... Adobe GoLive
Art Jones.................... Adobe Live Motion
Les Fuches ...................Adobe Photoshop 
Mel Martin ........................ Adobe Acrobat

ware, GoLive web publishing software, 
and Adobe Acrobat, the document pub-
lishing application.

The highlight was, of course, the 
product raffles at the end of the meet-
ing. The audience was rewarded for 
staying late with a huge product give-
away consisting of copies of Photoshop 
6, LiveMotion, GoLive 5, and Acrobat 4, 
almost $2000 worth of software!

So sometimes adversity can carry 
hidden benefits. We crammed 3 great 
speakers into one, as it turned out, won-
derful meeting. Next month the topic 
will again be web publishing with a 
demonstration by Macromedia.

from LaCie in the audience, Jerry 
McLean, who gave a restless audience an 
impromptu demonstration of their line 
of monitors and storage peripherals. I’d 
love to see their top of the line 21” 
flat panel display next to the Apple 22” 
cinema display and see which had a the 
best image quality. The LaCie display 
was certainly beautiful! Check out all the 
LaCie products at www.lacie.com.

After a late start, Adobe software engi-
neer Robert McDaniels gave the group 
a terrific presentation on Adobe’s 
collection of web development prod-
ucts, including Photoshop Elements, 
a brand new, extremely affordable 
(less than $100) image-editing product. 
Robert also demonstrated Photoshop, 
the industry standard image editing 
application, Live Motion animation soft-

mailto:stan_allen@atlmug.org
http://www.bignerdranch.com
http://www.lacie.com
http://www.atlmug.org/
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DIRECTIONS TO MACQUARIUM:
From I-85 South:

Take Peachtree Street exit 28. This exit 
becomes GA-13 S. Take Peachtree Street exit 
ramp towards Buckhead. Merge onto Peachtree 
Rd. NE. Travel approximately one-half mile, 
MacQuarium building is on your left. Parking 
entrance is on far side of MacQuarium sign next 
to R. Thomas.

From Ga 400 South:
Take the Sidney Marcus Blvd. exit, towards 
Piedmont Rd. Turn Left onto Sidney Marcus 
Blvd. Take the US-19 North/ Peachtree St. 
ramp North, towards Buckhead. Merge onto 
Peachtree Rd. NE. Travel approximately one-
half mile, MacQuarium building is on your left. 
Parking entrance is on far side of MacQuarium 
sign next to R. Thomas.

From I-75 South:
Take the 14th/10th Street exit. Turn left onto 
14th Street go 1/2 mile. Turn left onto 
Peachtree St. Go 2 miles and the road will 
fork; bear to your right. Pass behind the Equifax 
building, approximately one mile. MacQuarium 
building is on your left. Parking entrance is 
on far side of the MacQuarium sign next to R. 
Thomas.

From I-20:
Head towards 75/85 connector. Go north on 
75/85. Take the 14th/10th Street exit. Pass over 
10th street. Turn right onto 14th Street. Turn 
left onto Peachtree. MacQuarium building is 
on your left, approximately one mile. Parking 
entrance is on far side of MacQuarium sign next 
to R. THOMAS

AMUG MEETING SCHEDULE
 6/19/01 - Macromedia
 7/24/01 - iMovie and the Video Revolution
 8/21/01 - Apple Computer’s Macworld: New 

York Update
 9/15/01 - Maclanta Xpo 1.5 – Guest pre-

senter Microsoft
 10/16/01 - TBA
 11/20/01 - Mac Holiday Gift Ideas
 12/18/01 - TBA (Christmas Party)
Note: Remember, all dates and topics are sub-
ject to change. Please check back periodi-
cally for updates. All meetings except for the 
Maclanta Xpo are at Macquarium unless oth-
erwise noted.

2) Highlight Descriptive text goes here 
and type appropriate text.

3) Highlight the line of text and go to 
Edit>Style>Literal HTML. (It will appear 
as fixed-pitch, plain text but when opened 
in a browser the HTML will not show.

To link to another page: If you 
want to have another page, perhaps 
called a Family Page, you would go to 
the Message menu and choose New Doc-
ument Special>Home Page. To rename 
this page, go to File>Get Info on a Mac, 
or File>Properties on a PC. Rename it 
something other than Home Page, with no 
spaces. On your home page, create a link to 
this page following the directions in previ-
ous section.

Viewing Your Home Page
If you are logged into a FirstClass 

email server, you can see the contents of 
a user’s home page folder by choosing 
Conferencing>Directory, selecting the 
user, then clicking Home Page. Home page 
contents will look like plain text files when 
viewed this way rather than through a web 
browser.

Anyone with Internet access can use their 
web browser to view your home page. 
They just need to know your name and 
the domain name of our server; http://
atlmug.org/~firstname_lastname

For example, to see Sheryl McDonald’s 
home page at atlmug.org, an Internet user 
would type (with no spaces):
http://atlmug.org/~Sheryl_McDonald/

CONTINUED ON PAGE 12

BE A FIRSTCLASS EXPERT
Sheryl McDonald, Telecom Director
(sheryl_mcdonald@atlmug.org )

Did you know that you can have a web “Home Page” with your 
FirstClass Email account? You don’t need to know how to write 
HTML code to do it, and you don’t need an internet account.

Let’s walk through the steps to creating 
your first home page.

Getting Started
To create your Home Page, log into 

your email account, then choose 
File>Open>Home Page. A Home Page 
Folder icon appears on your FirstClass 
Desktop. You can only have one home page 
folder. You can rename or delete it, but do 
not move it off the Desktop. Your home 
page must stay on your Desktop to work 
properly.

Creating Home Page Documents
Now that you’ve created your Home Page 

folder, your next step is to create a Home 
Page document. Go to the Message menu 
and choose New Document Special>Home 
Page. You can start by typing text. You can 
change the font , size, style and color 
of text just as you would in a word proces-
sor. You can also Spell Check (Go to the 
Edit>Check Spelling).

To insert a horizontal line: Go to 
Edit>Insert>Insert Horizontal Rule

To add a picture: You can copy a pic-
ture from another application and paste 
it in your HomePage, OR you can go to 
Edit>Insert>Insert File and select the 
file you want to use. You can edit the image 
attributes using control click on Mac, or 
right click on Windows. Control-click the 
image and select Format Image from the 
pop-up menu.

To link to different web pages: You 
could just type in the address of the page 
like http://www.atlmug.org/ or if you are 
just a little more adventurous, you could 
copy the following text (it can be all on one 
line):
<A HREF=”URL goes 

here”>Descriptive text goes here 

</A><BR>

This is a little bit of HTML coding that you 
just paste into the desired location.

1) Replace “URL goes here” with a web 
address, which you can copy and paste from 
a browser.

AMUG Classifieds
-----------------------------------------------------------

Submissions can be made to 
maclanta@atlmug.org

-----------------------------------------------------------
FUJI film DX-10 digital Camera in A-1 Shape all 

cables and manuals in bags still. Used about 
4 times. Asking $150. Doug Franks - (770) 
592-6501

-----------------------------------------------------------
Apple PowerBook Extras:
• Apple PowerBook VST Auto Adapter. Works 

with 1400/3400/3500. $35
• Apple Powerbook 5300/190 or 3400/3500 G3 

floppy module $45
• Apple Powerbook 5300/190 battery charger 

station. Just plug your power supply in it and 
you are ready you charge 2 batteries. $35

• Apple Powerbook 3400/3500 (G3) CD 
module. Works great. $75

• Apple PowerBook 3400 96 MB ram module. 
$75. Doug Franks - (770) 592-6501

-----------------------------------------------------------
Powerbook 5300cs, $100.00 as is. This unit did 

work but I can not get it to boot. It may be 
a fixer-upper or a parts machine. The power 
supply brick needs a new end that goes in the 
PowerBook. Doug Franks - (770) 592-6501

-----------------------------------------------------------
I have a personal LW 4/600 with low page count, 

and new toner. $150 Doug Franks - (770) 
592-6501

-----------------------------------------------------------

mailto:sheryl_mcdonald@atlmug.org
mailto:maclanta@atlmug.org?subject=classifieds
http://www.atlmug.org/meetings/directions/macquarium.shtml
http://www.atlmug.org/meetings/June01.shtml
http://www.atlmug.org
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Mac. You can either take a full screen 
capture (everything currently showing 
on your monitor will be placed in an 
image) or select a portion of your screen 
that you want a picture of (e.g. a folder 
window, an application tool bar, a web 
page, etc.). The resulting image will 
be placed on your hard drive in PICT 
format.

As a minor digression and a quick 
lesson on image formats: the PICT 
format is specific to the Macintosh com-
puter platform (there are applications 

for Windows that can open PICT files, 
but they’re not common). If you are 
sending your screen shot to a friend 
with a Mac, they will have no problem 

While there a number of appli-
cations that can provide you 
with the capability to take screen 
shots (and we’ll go over those in 
another column), did you know 
that your Mac has that ability 
built into it? The simple task 
of pressing a few buttons on 
your keyboard will result in 
permanent record of an event, 
accompanied by a cool “camera 
shutter” sound.

You have two options when 
taking a screen shot on your 

Say cheese! Here’s your entire desktop…

A PIECE OF THE ACTION
By David Whitehead, Publicity Director 
(david_whitehead@atlmug.org )

As a big believer in the whole “picture is a worth a thousand 
words” adage, I often use screen shots to illustrate my points. 
In fact, screen shots are a very handy tool to help teach my 

mom how to use her new iMac (she lives in Ohio, so it’s not exactly con-
venient for me to drop by when she has a question). And a good screen 
shot is also a great way to share that record-setting session of Snood or 
Maelstrom. The next few columns will show you how to share the action 
on your Mac.

Need a quick listing of a folder’s contents?

CONTINUED ON PAGE 12

mailto:david_whitehead@atlmug.org
http://www.macquarium.com
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MAC OS 9.2: WHAT DOES IT 
MEAN TO YOU?

By Brian Tobin 
(brian@artificialcheese.com)

(Originally published at Artificial-
Cheese - http://artificialcheese.com/
articles/may01/macos92/)

Whether you’re stuck on OS 9, 
or whether you’re looking for a 

new update to OS X, many users have 
been anticipating Apple’s next release of 
OS 9. But few know what it will bring, 
or to whom in which it will bring it. 
Some might even wonder why Apple is 
bothering to update the OS, since their 
newest and coolest is already out. We’ll 
do our best to answer these questions in 
today’s article.
Apple Ties Off Loose Ends

OK. It’s school time again, and today’s 
subject is Apple’s OS plan. They recently 
released OS X, and with it came many 
new changes. But not all computers can 
run the new OS, and so Apple has a 
loose end to tie up.

A few years ago, Apple was faced 
with nearly the same situation. The cur-
rent OS was System 8.0, which ran on 

both PPC and 68k machines. Apple’s 
next system, 8.5, only ran only on PPC 
machines, and so Apple needed to come 
up with a system that pre-PPC custom-
ers could use for years to come. The 
result was MacOS 8.1. After this update 
was released, Apple considered the 68k 
machines dealt with, and has never 
given them a major update since.

Just like they gave pre-PPC machines 
MacOS 8.1, Apple has been planning to 
give pre-G3 machines a nice, stable, and 
“completed” version of OS 9. Now that 
OS X is out, it’s only a matter of time 
before Apple releases a new version of 
OS 9, and freezes it forever.
What’s a “Freeze” Mean

To answer that question, we’ll first 
take a look at a few examples of what 
Apple has done to tie off loose ends 
in the past. What file system does OS 9 
use? HFS Plus, the same as OS 8.1. What 
types of applications can be run on OS 
9? The exact same as can be run on OS 
8.1. In fact, the two systems are compat-
ible in formats, network protocols, and 
system structure. In short, before Apple 
stops updating a system, they make sure 
it will be relatively future-proof. Think 

of it as a conso-
lation prize, since 
the harsh reality is 
that you and your 
old computer are 
being left behind 
in the dust.

So now you get 
the gist of what 
Apple needs to 
do. They need to 
tie off OS 9 by 
making a stable 
version that can 
be used by pre-G3 
machines for 
years to come. 
Protocols, for-
mats, and appli-
cations should all 
be compatible. 
Now let’s look at 
some key issues 
that should be 
wrapped up 
before OS 9 is 
frozen.
The End Goal

Application 
support is a 

must. If you have a pre-G3, you must be 
able to run carbonized versions of your 
favorite applications. Apple has done a 
wonderful job of implementing this con-
cept since the very beginning with their 
CarbonLib system. If you’re not familiar 
with CarbonLib, it’s an extension used 
with MasOS 8.6 or later that enables you 
to run Carbon programs. As far as appli-
cation support is concerned, consider 
this end tied.

Another feature we should expect in 
the frozen version of OS 9 is one trans-
forming the system from a single user 
environment to a multi-user environ-
ment. One thing that you’ll notice right 
from the start when running OS X is 
how much it utilizes networks, and how 
easy it is to run the computer with 
multiple users. OS 9 currently has an 
impressive multi-user interface, but it 
still has a ways to go before it’s frozen.

But these two examples are areas 
where OS 9 needs to catch up with 
OS X. We also must realize that OS X 
actually needs things from OS 9, primar-
ily because of the Classic environment. 
Currently, if you run a classic program 
in OS X, your computer will first boot 
up OS 9.1, and then run the app. The 
problem with this is that it’s prone to 
crashing, uses up lots of RAM, and is 
often slow. Although Classic isn’t going 
anywhere, we can expect many improve-
ments before the freeze.

Apple realized that not every devel-
oper was going to port their programs 
overnight. That’s why they made classic 
work. Now that things are able to get by, 
they’re out on a new mission: to make 
things work well.

OS 9.1 wasn’t extensively designed to 
run things quickly under OS X. The next 
versions of OS 9 should operate better 
on OS X when called through Classic. 
Much work is being done to enable OS 
9 and OS X to work hand in hand. The 
results will be better speed, better com-
patibility, and less resource drain.

In fact, Apple can’t just do a standard 
wrap-up on OS 9. Because OS 9 is an 
integral part of OS X, Apple is finishing 
the system not only for old machines, 
but for future machines as well. All in 
all, we won’t stop using OS 9 for a long 
time, and Apple is putting in the effort 
to make the final version as good as 
possible.

MacMedic
We service the best computer in the 

world, the Apple Macintosh.
Our technicians support all Mac 

operating systems (including Mac 
OS X), Apple CPU’s and networks. 
From your office to your home, we 
will service your needs in a speedy 

and cost effective manner.

Based in Atlanta, GA and a proud member of 
the Atlanta Mac User Group (AMUG).

All Apple Computers including the iMac, iBook, 
PowerBook G4, G4 Cube, PowerMac G3

Operating Systems from System 1.0 through OS X

Warren Castaneira
P.O. Box 1685 • Kennesaw, Georgia 30144

404-358-1388 • macmedic@mindspring.com
CONTINUED ON PAGE 11

mailto:brian@artificialcheese.com?subject=MacOS9.2 Review
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PAGE 10

TITANIUM POWERBOOK G4: THE 
ULTIMATE MOBILE MAC?

By Chuck Joiner
(chuck@chuckjoiner.com)

“…you’re so gonna’ want one.”

That line from the TV commercial for the new Titanium G4 
PowerBook pretty  much says it all. Apple introducing a new 
PowerBook in San Francisco in January was no surprise; a new 

model was speculated on and expected. What wasn’t expected was the 
Titanium PowerBook, arguably the most lusted-after Macintosh ever. 
Striking for both performance and looks, the “TiBook” has been selling 
faster than Apple can supply them. Here are some of the reasons why.

(This review is based on the 
PowerBook G4 500MHz model, 500MB  
RAM, 20GB hard drive.)
The Outside

The Ti inspires an unusual sense 
of reverence. Unlike the black plastic 
cases of yesteryear, the silver-finished 
titanium shell gives it a sleek, stylish 
appearance even though it is not 
as curvy as the predecessors. Closed 
or open, it is wider than previous 
models, but that only makes it more 
appealing, not more cumbersome.

Lighter than previous PowerBook 
models, it seems even more so when 
you hold it in your hands because of 
the 1” thickness. If you were used to 
the heft of the Wall Street, Lombard 
or Pismo PowerBooks, this one will 
surprise and delight you.

One thing which you’ll immedi-
ately notice is that the Apple is finally 
oriented correctly to be upside down 
when closed in front of you and right 
side up when open. That’s just fine, 
because with this Mac, you’ll rarely have 
it closed.

Another change is a small white LED 
near the back of the closed lid which 
slowly pulses when the Ti is asleep. It is 
both more subtle and more visible than 
the old blinking LEDs.

When you open the Ti for the first 
time, you will gasp at the screen. Gor-
geous! It is amazing how much differ-
ence an inch or so makes. Maybe the 
screen really is brighter than other note-
books, or just seems that way because 
there is so much of it. Either way, it is a 
pleasure to have room for two separate 
full-sized windows or one with plenty of 
room for tool palettes. This is probably 
the biggest selling point of the Ti, aside 
from the impact of its appearance.

The back panel sports all the current 

standard interfaces, including USB, 
FireWire, Ethernet, modem, IR, etc. Dis-
connecting the Ethernet cable can be 
a little difficult because of the lip cre-

ated by the hinge and the thin body 
of the Ti. If you have large fingers, this 
may become an inconvenience because 
you’ll need something thin to press 
down on the tab of the Ethernet cable 
connector.

While not obvious, there is a single 
PC card slot on the left side of the Ti, 
disguised as a ventilation port because 
of the grill-like cover.
The Inside

What’s the first thing any Mac enthusi-
ast does when he gets a new machine? 
Grabs the appropriate tools and takes a 
look under the hood, of course! That’s 
exactly what you’ll need to in order 
to upgrade your Ti. Installing RAM is 
as easy as past models. Release two 
catches, flip the keyboard off and you 
have easy access to the RAM slots.

Installing an AirPort card or new hard 
drive is a bit more problematic. To 
accomplish this, you must remove the 
bottom of the Ti, which requires a 

Phillips screwdriver and some patience. 
Because of the tight tolerances involved 
in this Mac you must be extra careful 
not to scrape the case. Also, because it is 
now metal, there is a danger of bending 
and warping the case if it doesn’t come 
off easily.

Once off, installing an AirPort card is 
simple. Raise the bracket which holds 
the card, connect the antenna connector 
and you are ready for wireless Internet 
access. Upgrading the hard drive may be 
a bit more difficult because it requires 
the dreaded Torx screwdriver and there 
isn’t much working room inside. If you 
know you’re going to need a bigger 
hard drive than the standard configura-
tion, it would be best to get the upgrade 
when you first buy the Ti.

Replacing the case takes at least 
as much care as getting it off. You 
must be sure that all the side tabs 
are tucked under the case and that 
the screw holes all line up exactly 
or you again run the risk of bending 
the case. It isn’t difficult if you are 
careful and patient.
Operations

Using the Ti is a joy. The keyboard 
feels good… as good or better than 
previous PowerBooks. The trackpad 
appears unchanged, but the button 
has been relocated slightly due to 
the design of the case. It is amazing 
how you can become not only a 
touch typist but also a touch mouse-
buttoner (a new phrase is invented!), 

and you will find yourself pushing down 
on the metal below the button for a 
little while. A week of adjustment and 
you won’t miss a click.

Another great feature which seems to 
have been overlooked in much of the 
initial coverage is the “smart” Ethernet 
port. The port now senses what it is 
being connected to. A standard Ethernet 
cable can be used to connect to either 
a network or another Mac. No crossover 
cable required! This is a little nicety you 
won’t truly appreciate until you are on 
the road and desperate to connect to 
something but think you don’t have the 
right cable.

Because the entire Ti is now almost 
thinner than the old PowerBook power 
adapter plugs themselves, you won’t 
be able to use your old spares. Too 
bad… maybe we could convince one of 
the accessory manufacturers to make an 

CONTINUED ON PAGE 11

Apple’s new iBook looks sleek, and lets you edit your own 
digital video for less.

Im
age courtesy of Apple Com

puter

mailto:chuck@chuckjoiner.com?subject=TiBook Review in Maclanta
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ALADDIN TRANSPORTER
By Debby Kratovil
(kratovil@his.com)

While I admit I am a software junkie 
and can always find a use for any soft-
ware, no matter how old the version 
or how small the job it claims to per-
form, I couldn’t get excited about Alad-
din Transporter. I couldn’t live without 
Aladdin’s giant can-opener “Stuffit” and 
use it almost daily. But after I installed 
Transporter and read the documenta-
tion and looked through the long list 
of features and functions, I realized that 
automated scripts for several tasks was 
not up my alley. Transporter claims to 
“turn complicated tasks requiring mul-
tiple steps in several applications into 
a simple drag and drop action, by creat-
ing your own custom drop box applica-
tions.” But a lot of these tasks I already 
do in just one or two steps. After all, 
I use a Mac which simplifies everything 
computing!

“Make Alias,” “Archive,” “Expand,” 
“Open URL,” “Send Email,” “Play Movie” 
just didn’t excite me. As a Macintosh 
user I don’t take multiple steps to do 
these things. Transporter guides you 
through creating  little scripted drop 
boxes for individual tasks. But for the 
life of me I couldn’t get one to behave 
and actually function. Another sad tale 
of not having a hardcopy manual as a 
go-with for the software.

Because I am wont to never abandon 
any software until I’ve test driven it into 
the ground, I know I will fire up Trans-
porter on my beloved G3 once again 
and perhaps this time, Scottie can beam 
me up.

adapter?
Battery life is definitely longer than 

the Lombard or Pismo, but whether it 
can make the advertised 5 hours will 
depend on what you’re doing with it. 
With minimal hard drive access it is 
probably an achievable feat.

The Airport capabilities work flaw-
lessly. Some have reported reduced 
range as compared with prior Power-
Books. Since this was my first experi-
ence with the Airport I was overjoyed 
to be able to access the Internet from 
anywhere in my townhouse; if there is 
reduced range it didn’t apply to my situ-
ation.

The slot-loading DVD drive takes a 
little getting used to. Reports from some 
of the very early adopters referenced 
having difficulty getting CDs and DVDs 
in and out. This has not been an issue 
for me, but I echo the opinion of a 
New York tech support firm: the drive 
has a fabric at the slot opening which 
is stiff when new. With a little use it 
softens and media go in and out more 
smoothly.  

If there is a downside to the new Ti, 
it is a very small one. The built-in speak-
ers don’t sound quite as good as their 
predecessors. Whether it is the type of 
speaker used or the titanium case, the 
sound is thin and a little tinny. If you 
are going to listen to MP3’s or play a 
DVD on the plane, you’ll want to take 
advantage of the conveniently located 
headphone jack or external speakers to 
make your experience more enjoyable.

One of the big stumbling blocks to 
putting a G4 chip in a PowerBook was 
the heat issue. Whether it is the Ti’s fan 
or the fact that the titanium case helps 
dissipate the heat (essentially making 
the whole case a heat sink), the com-
puter doesn’t seem to get any warmer 
than the Lombards or Pismos did. You 
might not want it on your bare legs for 
hours on end, but it isn’t as hot as you 
might think.
The Bottom Line

If you have been waiting for the ulti-
mate laptop, wait no longer. If you are 
already a PowerBook owner and are 
thinking of upgrading, don’t hesitate.

Copyright 2001 Chuck Joiner. 
This article originally appeared in 
“Seeds,” the newsletter of The Her-
shey Apple Core, May 2001.

What’s Happened So Far
Recently, Artificial Cheese was able to 

obtain a copy of MacOS 9.2b4 and use 
it on our test machines. Although we 
don’t know whether 9.2 will be the last 
of the 9 series, we do know it’s headed 
in that direction. So what’s our impres-
sion of the system? The 9.2 update is 
very nice.

If you boot straight into MacOS 9.2, 
you’ll notice some of the MacOS X 
elements mentioned earlier. The first 
screen you’ll see is a network login at 
startup; one that is very similar to that 
of OS X. If you bother to look, the first 
extension to load is the network exten-
sion. It looks like MacOS 9 is learning a 
few habits from OS X.

And what about application support? 
As I mentioned before, CarbonLib has 
been available for quite some time. 
Right now the publicly available version 
is 1.2.5, but the version included in 
9.2b4 is version 1.3.1. Clearly this shows 
that Apple is still continuing their efforts 
to support new applications with older 
computers. Again, very cool.

But these “tie up” features are normal, 
and to be expected. The biggest and 
most important changes that we’ve 
noticed are the dramatic speed increases 
when running the beta within Classic 
on OS X. Before the update, many of 
our staff members made the practice 
of switching from OS X to OS 9.1 
before using classic graphic programs. 
After installing the beta, none of us had 
any qualms with using Classic for every-
thing, and programs absolutely fly.
What’s It All Mean

First and foremost, this shows that 
Apple is tying up OS 9, just like they 
tied up OS 8.1. It also means that 
Apple is making dramatic under-the-
hood changes that will benefit MacOS X 
users. So look out Mac faithful, because 
the racehorse that Apple calls OS 9.2 is 
coming to town!

Editor’s Note: As of May 30th, 
Apple had released the fourth 
final candidate version of Mac 
OS 9.2 (f4c2). A final candidate 
usually is complete expect for 
minor documentation, and last 
minute minor tweaks. My guess 
- expect it at Macworld in July, if 
not sooner.
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Classifieds & Advertising Info
Maclanta is looking for classified ad 
submissions from AMUG members. 
You can classified submissions can be 
made by emailing maclanta@atlmug.org, 
or by using the stationary file found in 
many of the for sale areas of the online 
community. Classifieds are free and 
must be resubmitted each month. Clas-
sifieds should include a brief descrip-
tion, suggested price, and a means of  
contacting the seller.

Non-AMUG members, or Members 
wishing for more substantial advertis-
ing, can contact maclanta@atlmug.org 
for advertising rates.

mailto:kratovil@his.com
mailto:maclanta@atlmug.org?subject=Classifieds
mailto:maclanta@atlmug.org?subject=AdInfo
http://www.hersheyapplecore.com/
http://www.hersheyapplecore.com/


NEC SilentWriter 95f laser printer works with 
Windows or Mac. PostScript level 2, HP Laser-
Jet  lll Emulation, Standard parallel, serial & 
AppleTalk ports, 2 font cartridge slots. Page-
count of 49,144. Asking $100. Doug Franks - 
(770) 592-6501

-----------------------------------------------------------
Apple Color OneScanner. $35 Doug Franks - 

(770) 592-6501
-----------------------------------------------------------

Two Apple 17” displays “very nice picture.” 
$70/ea. Doug Franks - (770) 592-6501

-----------------------------------------------------------
AppleVision 17” display. $85. Doug Franks - 

(770) 592-6501

viewing the PICT file. However, if you 
are sending your screen shot to a friend 
with a PC, they may have difficulty in 
opening an image file saved as a PICT. 
To ensure that everyone can open your 
screen shot when you send it, convert 
the PICT file into a JPEG (also known as 
a .JPG file in the Windows world) and 
add the three-letter file extension (the 
aforementioned .JPG) to the end of the 
file name. I recommend the great share-
ware application Graphic Converter to 
do the conversion.

We now return you to your regularly 
scheduled article.

Now that we’ve covered some general 
stuff, let’s get to good stuff: how you 
actually take a screen shot. As men-
tioned earlier, there are two types 
of screen shots you can create. To 
create the full screen shot, simply 
press command+Shift+3. You’ll hear 
the camera shutter sound and if you 
open your hard drive, you’ll find a 
PICT file named ‘Picture 1’. Voila, you’ve 
taken your first screen shot!
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screen capturing, press 
command+shift+4. Your cursor will 
change from an arrow to a crosshairs 
icon (a “plus” sign). Press your mouse 
button down (and keep it held down!) 
and use the crosshairs to draw a border 
around the item you want to capture. 
Once you have the border you want, 
let go of the mouse button. You’ll hear 
the familiar shutter and you’ll see your 
screen shot on your hard drive (most 
likely named ‘Picture 2’ if you kept the 
first picture around.

Screen shots are a great way to 
illustrate a point, provide instruction, 
or boast a little bit (in the case of 
high scores or really cool explosions in 
death matches) to your compatriots. In 
the upcoming articles, I’ll cover taking 
screen shots in Mac OS X, and other 
applications you can use to do screen 
captures in Mac OS 9. In the meantime, 
instead of using text to explain things, 
why not share a little piece of the action 
with a screen?

‘Till next time…

Editor’s Note:
I would like to personally apolo-
gize to the Membership and the 
Board. Last months newsletter 
went unpublished due to per-
sonal issues I had to deal with. 
I hope that his months news-
letter makes up for missing last 
month.

 -Chris Waldrip
 Newsletter Director

Atlanta Macintosh Users Group
PO Box 15130

Atlanta, Georgia 30333-0130




